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Presented by Nick Tussing, Zac Perkins

DESIGNER 301: 

MACROS
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AGE-
NDA

Part I:

• Macro review

• Improving the Sample Tool

• Interface Elements

• Messaging

• Macro engine behavior

• Exercise
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GOALS

In this session, we expect that you may be comfortable in standard 

macros and may dabble in iterative/batch macros. Our goal is to get you 

better acquainted with these macros, and building them in creative 

ways you may not have thought to use them!
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WHAT IS A MACRO?

It’s the Alteryx SDK for Alteryx
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YOU ALREADY WORK WITH MACROS!
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CHANGE THE MACRO USER SETTINGS

INSTRUCTIONS RESULTS

• Go to Options > User Settings > 
Edit User Settings > Canvas

• Select ‘display macro indicators on 
tools’

• Drag a Data Cleanse tool onto the 
canvas

• Open the macro and view the 
underlying tool
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WHY MACROS?
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REASONS TO GO MACRO

1. Address a repetitive functional or business process

2. Make processes more approachable for less experienced users

3. Solve problems faster

4. Make the Designer work the way you need

5. Be an innovator
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MACRO INPUT/OUTPUT

Macro Input Macro Output
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WHEN DO I USE THEM?

• No Macro Input

• No Macro Output
• 1 Macro Input

• No Macro Output

• No Macro Input

• 1 Macro Output

• 1 Macro Input

• 1 Macro Output

As many as you want!!



6

# A LT E R Y X 1 8# A LT E R Y X 1 8

BUILDING OUR FIRST 

MACRO: IMPROVING 

AN EXISTING TOOL
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MAKING A NEW SAMPLE TOOL

Example:

Often, but not always, you may be 
dropping two sample tools simultaneously 
onto a canvas. In this case, we have an 
example of a file that requires a set of 
passing to a row 1 (headers) and the rest 
of the data.

Wouldn’t it be nice to just do this in one 
tool?!
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WHAT DO WE NEED TO 

ACCOMPLISH THIS TASK?

Desired tool
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WHAT DO WE NEED TO 

ACCOMPLISH THIS TASK?

Desired tool

1 macro input 2 macro outputs
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WHAT DO WE NEED TO 

ACCOMPLISH THIS TASK?

A set of radio buttons for each action

A text box to enter a number

A list to select field groupings
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WHAT DO WE NEED TO 

ACCOMPLISH THIS TASK?
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RADIO BUTTON TOOL

• Enter text to be displayed

• Would you like this radio button to be 

selected by default?

• Collapse group when deselected

• Want a different configuration 

experience per radio button?

• Use the collapse group when you 

want to toggle different 

configuration grouping options
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TEXT TOOL

• Simple configuration

• Enter prompt text for ‘N=’

• Do you want a default value?

• Other options

• Text masking

• Multi-line text box for longer questions

• Hide control – text box is hidden to end 

user but is available to developer for 

testing.
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LIST BOX

• Easiest to use when interfacing with a tool 
with the ‘embedded select’ functionality

• Chose whether all fields should be 
selected be default or not

• Use ‘select tool mode’ to interface with 
embedded selects

• Other outputs a string of fields and 
‘True/False’ indicators

• Select which field types a user will be 
able to select
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LIST BOX (CONT.)

• List box is special because it can 

receive question values!

• This allows the macro input to detect 

what field names/types are entering 

into the macro, and dynamically 

creating a list based on the fields 

available at that time.
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MAKING A BETTER SELECT TOOL

INSTRUCTIONS RESULTS

• Since a sample tool should work on 

anything, start with any file. 

• Using a list box, radio buttons, and 

a text tool, replicate everything that 

a sample tool can do, but add an 

output for what was not sampled.
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…BUT WAIT, THERE’S MORE

Unfortunately, the error tool is only effective for applications. 
There is another tool we could use to get the tool to error 
under the wrong input. 

We have a working sample tool! However, we could add a safety to 

ensure that the ‘N=’ freehand text box only received numbers. 

Currently, our tool doesn't error if a non-numeric value is entered.
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HOW DO YOU PASS MESSAGING 

FROM YOUR MACRO?

• For interface tools in macros, and 

easy way to check values is to 

drop them into a single text input 

tool an evaluate them.
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MESSAGE TOOL

• The message too affects data in no 

way – it only evaluates the state of the 

data itself.

• Select when to pass a message

• Select the type of message to display

• Enter an expression that will display at 

the error.
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PUT A MESSAGE TOOL INTO 

THE IMPROVED SAMPLE TOOL

INSTRUCTIONS RESULTS

• Populate a text input tool with the 

value entered into the text box

• Add a message tool

• Evaluate if the data is a number or 

not

• Create an message to display if the 

value is not a number.
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HACKING STANDARD 

WORKFLOWS
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A QUICK NOTE

What we are about to show is in NO WAY supported by Alteryx, but is 
an interesting way of understanding engine behavior. 

We will show workflow ordering with macros, but there can be many 
‘gottchas’ along the way and should not be utilized in a production 
environment.
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ANYONE HAVE WORKFLOWS 

LIKE THIS?
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ANYONE HAVE WORKFLOWS 

LIKE THIS?
• Output file of second 

stream is the input of the 

third stream.

• Sometimes it works

• Sometimes they collide

• Sometimes they run in 

the wrong order.

# A LT E R Y X 1 8

TURN THE WORKFLOW INTO MACROS

Turn each flow into a macro

Macro 1

Macro 2

Macro 3
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DROP THE MACROS ONTO A 

NEW CANVAS
Note: These ‘tools’ will now run ordinally.

• Order will depend on the order they were placed onto the 

canvas (Tool NodeID).

• If workflow 2 was deleted and then readded, it would not be the 

last to run

• PRO TIP (unsupported) – Updating the tool NodeID in the 

XML will return order to the workflow
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EXERCISE



17

# A LT E R Y X 1 8# A LT E R Y X 1 8E X E R C I S E

BUILD A NEW UNIQUE TOOL!

INSTRUCTIONS RESULTS

• The default for a unique tool is to 
return all fields, but to return only 
unique values for selected fields.

• Try building a unique tool that ONLY 
returns the fields being “uniqued”

• Start with 
03_unique_select/01_unique_start.yx
mc
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DESIGNER 301: MACROS

PART II
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Part II:

• Macro types

• Understanding grouped vs non-

grouped batches

• Parsing with a batch macro

• Dynamic formula

• Wildcard Input Macro

• Managing changing schemas

• Exercise
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OTHER MACROS 

TYPES REVIEW
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MACRO TYPES

There are four types of Macros typically used in the designer:

1) Standard Macro

2) Batch Macro

3) Iterative Macro

4) Location Optimizer Macro 

Most commonly used
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MACRO BEHAVIORS

Standard (SHARED PROCESS)

– Typical workflow

– Packaged set of tools

Iterative (DO UNTIL Condition)

– Repeating process

– Typically ends at a threshold

Batch (FOR EACH)

– Process Each individual record

– Process Each group of records
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STANDARD MACRO
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BATCH MACRO
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BATCH MACRO
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ITERATIVE MACRO
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THE BATCH MACRO
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WHY USE A BATCH MACRO?

Use when trying to change your type of analysis on a per group 

basis! 
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WHAT MAKES A BATCH MACRO 

A BATCH MACRO?
One thing is needed to qualify your macro as a batch macro:

Control Parameter

The Control Parameter input will appear as a ¿ below its input arrow on the macro tool 

icon. For each record coming into the Control Parameter input, the entire macro will be 

re-configured and run beginning to end
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WORKING EXAMPLE: STATE TAXES

An internet retailer has customers from all over the country. However 

separate logic has to be implemented on a state-by-state basis. State 

rates vary from 0%-8%. We need to build a batch macro to calculate 

what the total for the online shopping carts should be for each customer 

from each state. 
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WORKING EXAMPLE: STATE TAX

State Tax

CA .0725

CO .0290

FL .0600

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA

The ‘Question’
The Control Parameter

The Data
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NON-GROUPED

State Tax

CA .0725

CO .0290

FL .0600

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA

The ‘Question’
The Control Parameter

The Data1 100.00 CA

2 150.00 CO

3 200.00 CA

1 100.00 CA

2 150.00 CO

3 200.00 CA

1 100.00 CA

2 150.00 CO

3 200.00 CA
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FL .0600

CO .0290

CA .0725

NON-GROUPED

State Tax CA .0725

CO .0290

FL .0600CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA

The ‘Question’
The Control Parameter

The Data

1 100.00 CA

2 150.00 CO

3 200.00 CA

1 100.00 CA

2 150.00 CO

3 200.00 CA

1 100.00 CA

2 150.00 CO

3 200.00 CA

CA .0725

CO .0290

FL .0600

Batch 1

Batch 2

Batch 3

# A LT E R Y X 1 8

GROUPED

State Tax

CA .0725

CO .0290

FL .0600

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA
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GROUPED

State Tax

CA .0725
CO .0290

FL .0600

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA
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CA .0725

GROUPED

State Tax

CA .0725

CO .0290

FL .0600

CustID Trans State

1 100.00 CA

3 200.00 CA

2 150.00 CO



27

# A LT E R Y X 1 8

CA .0725

GROUPED

State Tax

CO .0290
FL .0600

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA

CA .0725
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GROUPED

State Tax

CO .0290

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA

CA .0725

CA .0725

FL .0600
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GROUPED

State Tax

CO .0290FL .0600

CustID Trans State

1 100.00 CA

2 150.00 CO

3 200.00 CA

CA .0725

CA .0725No data for CP Batch 1

Batch 2

Batch 3: No data
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PARSING A DIFFICULT 

TEXT FILE
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GNARLY DATA

Text file observations:

1) Header Row has multiple spaces between column names. All column names are 1 
words or 2 words with a space in between them.

2) Second rows - number of continuous dashes represents the field length

3) The data is below is a variant number of spaces

4) User says fixed wont work because it largely varies week to week, file to file.
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GNARLY DATA

What we need to do:

1. Separate data into three streams

1. The header names – simple parse should be all we need

2. The dash row – we will use this to generate a substring formula apply to the data 
below it

3. The data which will have the row 2 logic applied to it.



30

# A LT E R Y X 1 8

SELDOM SEEN TECHNIQUES IN 

THIS EXERCISE

• Use of the iteration number

• Few know it exists for batch macros

• Dynamically creating and applying a formula

• Ungrouped macro input

• Most batches are used in a group function to take only a set of rows, but in this 
case we are applying a different formulas across the whole set of data.

• Macro in a macro
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CLEANLY PARSE THE TEXT FILE

INSTRUCTIONS

RESULTS

• Input the text data

• Calculate field length using the dashes

• Create a batch macro that will dynamically apply a substring formula 

across all of the data.
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OTHER WAYS TO 

BATCH
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INGENIOUS BATCHING

Fun fact: you don’t need data to flow through this macro if you don’t 

want to! You can just use the batch input to run the workflow under a 

number of different configurations!
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VISUALIZING DATA-LESS BATCH

Alabama File

Alaska File

Arizona File
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VISUALIZING DATA-LESS BATCH
.\source\Alabama.csv .\dest\Alabama.csv

.\source\Alaska.csv .\dest\Alaska.csv

.\source\Arizona.csv .\dest\Arizona.csv

Workflow Runs
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WILDCARD INPUT 

MACRO
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SELDOM SEEN TECHNIQUES IN 

THIS EXERCISE

• Batch macro simply reconfigures a workflow

• A macro within a macro

• Interfacing with a macro embedded ‘two macros deep’

• Dealing with changing output schemas
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INTERFACE TOOLS USED

File Browse

Check Box

Drop Down

# A LT E R Y X 1 8

INTERFACE TOOLS USED
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FILE BROWSE

• Enter a text prompt

• Choose whether this file browse is to 

‘open’ or ‘save’ a file

• Choose one of the following options

• Standard DB formats

• Report formats

• Arbitrarily Specify a file

• Choose file types to search for
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CHECK BOX

• Identical configuration to the radio 

button

• However multiple selects can be 

chosen in an interface whereas only 

one button can be selected

• Passes a ‘true’ value when selected and 

a ‘false’ value when not selected.
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DROP DOWN

• Many different ways to generate list 

values

• Most common use – manually set 

values

• Create a list for a user to select by 

separating by a new line

• [Name]:[Value]

• [What displays to user]:[What 

variable the workflow actually uses]
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BUILD A WILDCARD INPUT TOOL

INSTRUCTIONS

RESULTS

• The wildcard functionality of the input data tool only works with matching 

schemas.

• Build a macro that will input any file, no matter what schema

• Note that one dataset has two extra columns in our sample data
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EXERCISE
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FILE MOVER MACRO!

INSTRUCTIONS RESULTS

• Create a macro that opens a list of 
files from one location and writes it to 
another.

• It will batch on the file

• The batch macro itself could have 3-4 
tools max!

• Start with 
06_file_move/01a_file_mover_wrapp
er_start
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DESIGNER 301: MACROS

PART III
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AGE-
NDA

Part III:
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STANDARD MACRO
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BATCH MACRO
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BATCH MACRO
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ITERATIVE MACRO
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HOW DOES AN ITERATIVE 

MACRO BEHAVE?

An iterative macro will run through ever record and then loop the 

records back through the workflow – repeating the entire process as 

many times as specified, or until a condition is met.
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WHEN SHOULD I USE IT?

Whenever you find a repeating sub process, you may 

have an excellent use case for the iterative macro!

In the above workflow, amortization of loans are being 

calculated. The workflow calculates  how many ‘rounds’ 

of payments it will take until the loans are paid off. This 

is an excellent example of an iterative macro, because the 

remaining principle must be recalculated at the end of 

every month. The amortization curve is not linear!
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AUDIENCE INTERACTION

Does anyone have any examples of what types of problems in our 

world iterative macros are good for?
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ITERATIVE MACRO TYPES

1) Run by a certain iteration count

- “Run this data through our macro 1000x”

- “What does 100 years of our growth projection look like?”

2) Run until a True/False Condition is met

- This method is used far more frequently

- Typically need to keep running an iterations until an answer is 

discovered.
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ITERATIVE MACRO KEY POINTS

Always requires an macro input tool

- Unlike the other macro types

- Inputs will serve as a spot where data 

re-enters macro for the next iteration

A true/false condition

- Not always required, but certainly the 

easiest way to get started

Answer output

Iterative Output

- Records using this macro 

output will return back to the 

macro input for another 

iteration.
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WORKFLOW AUTO TYPE 

DEFAULTS

• Default – .yxmd

• Standard macro – dropping a macro input/output on the canvas

• Batch macro – dropping a control parameter onto the canvas

• Iterative macro – does not automatically convert, must be 

changed in the workflow type settings
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WORKFLOW TYPE SETTINGS

• Adding a Macro Input changes it to 

Standard

• Adding a Control Parameter changes it 

to Batch

• You must manually select the Iterative 

Macro type
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VISUALIZING ITERATIVE 

MACROS

Number

10
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VISUALIZING ITERATIVE 

MACROS

Number

10

Number

5

Number

2.5

Number

1.25
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THE INTERFACE 

DESIGNER
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THE INTERFACE DESIGNER

View>Options>Interface Designer

Layout View

Test View

Tree View

Property View
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INTERFACE TOOL - PROPERTIES

Time to assign what input/output goes 

where!

• Select the iteration input

• Select the iteration output

• PRO TIP: Name your inputs and 

outputs to make this process 

simpler

• Choosing between Output17 

and Output32 is not helpful
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INTERFACE TOOL - PROPERTIES

Maximum Iterations:

• Is there a maximum number of 

times you want the macro to run? 

• If these limit hits, there are a few 

options… 
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INTERFACE TOOL - PROPERTIES

In this case, you can choose to do a 

few things when 100 iterations are 

run:

1) Fail the macro saying all data was 

not able to exit the macro before 

100 iterations

2) Let the macro complete the 

warning and pass the remaining 

rows out the Iteration Output

3) Output records out iteration output 

without warning
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INTERFACE TOOL - PROPERTIES

Output mode (advanced)

• Do you expect all iterations to be 

the same columns? For beginners, 

the answer is typically yes.

• If you add columns each iteration, 

you can configure all iterations to 

align via name or position.
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MACRO: PASCAL’S 

TRIANGLE BUILDER
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WHAT IS PASCAL’S TRIANGLE

# A LT E R Y X 1 8

WHAT MAKES THIS MACRO 

ADVANCED?

1) Variant schema

a) The more rows we ask for in the Pascal’s triangle, the more we get.

2) Changing Data

a) We start off with the number 1 and grow to many times that size. 

Sometimes your data can outgrow your datatypes
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CHANGING DATA
Situation: We have a macro that has an input of 1 penny 
(non-decimal) and we want to see how many pennies we 
have at the end of the month if we double them 
everyday.

Oopsie: We assigned int16 with a select tool to the penny 
field right after the macro input

Result: INT16 can hold up to 32,767.

Day 16 is 32,768 pennies.

Result for day 16 on – NULL

*Moral of the story – be painfully aware of your 
datatypes.
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PASCAL’S TRIANGLE BUILD

INSTRUCTIONS RESULTS

• Create a macro that generates a 

pascal’s triangle

• Allow user to select rows to be 

generated

• Columns generated should be equal 

to that of the rows
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NULLIFY THE DATA

INSTRUCTIONS RESULTS

• Create a simple iterative macro by 

create a 1x1 data table with the value 

of 1.

• Double the value of 1 over each 

iteration until the macro starts to return 

NULL() values for an Int32 datatype? 

What was the last iteration successfully 

logged? What was the last value?
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PART IV:

DEPLOYING MACROS
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DEPLOYING MACROS

You may have made your macros, but now they lack that final polish. 

In this section, you will learn how to make your macro nearly 

indiscernible from other tools in the Designer.
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MAKING A MACRO REPOSITORY

Options>User Settings>Edit User Settings>Macros

All macros in this folder will be placed into a 

new tool palette category named ‘Macros’. 

Pro tip: There is another way to move macro 

categories, so less search paths will make your 

life easier
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CHANGING A MACRO ICON
With the macro open: View>Interface Designer>Properties
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CHANGING A MACRO’S CATEGORY

• With the macro canvas, open 
workflow meta info.

• Click Canvas > Click Meta Info Tab in 
the Configuration Window

• Choose a new or existing category 
name

• Existing will include it in that 
category

• New will create a completely new 
category
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CHANGING A MACRO’S DISPLAYED NAME

# A LT E R Y X 1 8

CREATING A MACRO DESCRIPTION
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ADDING ANCHOR INDICATORS

# A LT E R Y X 1 8

MAKE IT SEARCHABLE!
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ADD HELP OPTIONS

Pro tip: Help also opens 

from ‘F1’ keystroke
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SHARING
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METHOD 1 – SEND FILE .YXMC

Sharing via file:

Risks:

• Only works if the file has no dependencies

• No files

• No other macros embedded

• Will create issues if macro input uses a file 

input – file will need to be shared too.

• Sharing on email

Pros:

• Easy
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SHARING METHOD 2

Sharing from a 

network drive:

Risks:

• Macro may not be accessible across VPN

• All risks that apply to network paths

• Others editing/deleting

• All people with access can see it

Pros:

• Easy

• Updating the macro instantly updates it for 

everyone
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SHARING METHOD 3

Sharing to and from 

the Alteryx Gallery:

Risks:

• Updating the macro to a new version would 

required share-ee to re-download the workflow

Pros:

• Easy to share/provision access

• Version Control

• Control which version is public
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SHARING TO THE 

GALLERY
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SAVE A MACRO TO GALLERY

# A LT E R Y X 1 8

SAVE A MACRO TO GALLERY
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SAVE A MACRO TO GALLERY
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SAVE A MACRO TO GALLERY
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SHARING WITHIN THE GALLERY

Share with everyone!

Share with a specific group only.
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ADDING TO A COLLECTION
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SHARING WITH OTHERS

# A LT E R Y X 1 8# A LT E R Y X 1 8

SHARING 

WORKFLOWS WITH A 

SPECIAL MACRO
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ERRONEOUSLY SHARED 

WORKFLOWS
If you built a workflow and used a macro not native to the Designer AND shared 

it to a coworker as a .yxmd, they would likely see this! While you had it available 

to you, they might not have it available to them.
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EXPORTING YOUR WORKFLOW

Instead, there is a way to include your macro!

Make sure to include your macro!

Share the .yxzp!
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ENCRYPTION

# A LT E R Y X 1 8

ENCRYPTING MACROS

If there is a macro tool that was built around a specific business 

practice and requires governance by not allowing others to customize 

the tool, encryption can be an excellent choice.
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ENCRYPTING A .YXMC

Options>Advanced Options>Encrypt Workflow

# A LT E R Y X 1 8

ENCRYPTING A .YXMC

Note that the default is to create an 

encrypted version to not overwrite 

current version. Be sure to share the 

encrypted version.
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ENCRYPTING A .YXMC

Enter certain serial numbers (email 

addresses) to allow only certain users to 

RUN the macro. If nothing is entered, the 

macro can be run by anyone, but cannot 

be opened.

# A LT E R Y X 1 8

ENCRYPTING A .YXMC

Enter a date to make the macro expire. 

Users will no longer be able to run the 

macro. It can be an excellent way of 

ensuring people stay up to date on 

versioning.
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ADDITIONAL 

THOUGHTS

# A LT E R Y X 1 8

MACRO MESSAGING

• When embedding a macro inside of a workflow, it may be hard 

to see what is happening inside of it. In other cases, it may error 

but you may be unsure as to what caused it. 

• Go to the runtime settings (in the canvas config) and select 

‘show all macro messages’

Without

With
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PERFORMANCE PROFILING

Gain insight to who performant (or not) your macro can be in the context of your 

workflow by enabling performance profiling in the runtime configuration settings.

# A LT E R Y X 1 8

CHECK OUT CREW MACROS!
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CHECK OUT THE ANALYTIC 

GALLERY FOR MORE!

# A LT E R Y X 1 8# A LT E R Y X 1 8E X E R C I S E

SAMPLE FILTER FINALE

INSTRUCTIONS

Do the following for the completed sample filter tool.

1. Map the macro into Designer

2. Add it to the ‘Preparation’ category

3. Make it searchable

4. Make a tool tip

5. Update Icon to anything but a blue dot

6. Encrypt the macro so it cannot be opened
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Q&A

# A LT E R Y X 1 8# A LT E R Y X 1 8

THANK

YOU

Please complete a 

feedback survey!

Amelia Glum

aglum@alteryx.com


